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Electronic Case Filing System 
User’s Manual 

 
Getting Started         
Introduction 
This manual provides instructions on how to use the Electronic Filing System to file documents 
with the court, or to view and retrieve docket sheets and documents for all cases assigned to this 
system. Users should have a working knowledge of word processing, web browsers, file 
management and Adobe Acrobat.   
 
Help Desk 
Contact the Court’s ECF Help Desk for assistance between the hours of 8:00 a.m. - 5:00 p.m., 
Monday through Friday. 

 
Local: 612-664-5155  
Toll Free: 866-325-4975 

OR E-mail:  ecfhelpdesk@mnd.uscourts.gov 

 
Access to ECF Information and Resources  

 
For up-to-date information regarding ECF, visit the U.S. District Court web site at: 
www.mnd.uscourts.gov 

 
The CM/ECF link provides access to:  
 
● Live login to CM/ECF 
● Automated Password Reset 
● General Information 
● Training Information 
● Reference Guides and User’s Manuals 
● CM/ECF Help 

 
 

mailto:ecfhelpdesk@mnd.uscourts.gov
http://www.mnd.uscourts.gov/
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Central Sign-On (CSO) Account 
In NextGen ECF, a Central Sign-On Account provides access to both PACER and ECF with a single login 
and password. Once logged in with a CSO account, admitted attorneys with filing privileges can: 

● Electronically file pleadings and documents 
● View official docket sheets and documents 
● View various case related reports  

 
Public Access to Court Electronic Records (PACER) Access 
PACER is an electronic public access service that allows users to obtain case and docket information from 
Federal Appellate, District and Bankruptcy courts, and from the U.S. Party/Case Index.  Attorneys must 
have an individual PACER account in order to file in the ECF system. All requests for ECF filing privileges 
are submitted through PACER. You may register for a PACER account online at http://www.pacer.gov/.  
Your CSO Account is maintained through PACER. Name, address, login, password and primary email 
address information can be updated in the “Manage My Account” section of PACER’s website.  If you have 
forgotten your PACER username and/or password, PACER has an automated password reset and 
username recovery on the PACER Login page.  
 

Electronic Case Filing (ECF) Access  
Existing attorneys (those who were admitted in the District of Minnesota prior to October 5, 2015 and have 
an active ECF account) will link their ECF account to their individual PACER account for filing access.  
Please see the NextGen Information page for additional information and procedures.  
 
Attorneys seeking admission and filing access must make a request through PACER. Please review the 
attorney admissions forms for specific instructions. Please note that pro hac vice and Multi District 
Litigation (MDL) attorneys also obtain filing access with the court through PACER.   
 
Attorneys will only retain filing access while in good standing with this court. To be in good standing, an 
attorney must comply with the requirements of LR 83.6, including timely payment of the re-registration fee 
due every third year during the court’s re-registration process.  If you do not re-register with the court, your 
admission status will become inactive. You will need to re-register with the court to return to good standing 
and have filing privileges reactivated.  After being admitted, attorneys must file a notice of appearance in 
the case(s) they wish to appear as attorney of record.   
 
ECF Training Database  
Current users can practice ECF activities by visiting the training version of the ECF system at https://ecf-
train.mnd.uscourts.gov.  We strongly recommend that users practice in the training ECF database before 
filing documents in the live ECF database. 

http://www.pacer.gov/
http://www.mnd.uscourts.gov/cmecf/nextgen.shtml
http://www.mnd.uscourts.gov/FORMS/court_forms.shtml#attorneyforms
http://www.mnd.uscourts.gov/local_rules/index.shtml
https://ecf-train.mnd.uscourts.gov/
https://ecf-train.mnd.uscourts.gov/


CM/ECF User’s Manual – Criminal  U.S. District Court, District of Minnesota 
 

  Page 6  

Logging in to ECF/PACER through CSO (Central Sign-On)   
1. Click on the U.S. District of Minnesota – Document Filing System link. To access this link either: 
 
 
 
 
 
 
 
 
 

a. Navigate to https://ecf.mnd.uscourts.gov/cgi-bin/ShowIndex.pl 

OR 

b. Navigate to the District of Minnesota’s Web site at: www.mnd.uscourts.gov and click on the 
NextGen ECF LINK on the left panel. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Enter your PACER/CSO Username and Password in the appropriate entry fields. 
Note that the Client Code is an optional field that can be used for organizing your monthly bill 
to associate costs to specific clients. 

 

 

 

 

 

 

  

https://ecf.mnd.uscourts.gov/cgi-bin/ShowIndex.pl
http://www.mnd.uscourts.gov/
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3. Check the box confirming you will comply with the redaction rules. Click Continue and the 
main ECF screen will appear. 

 

 

 

 

 

 

 

 
Logging Out 

After you have completed all transactions for a particular session in ECF, you should exit from the 
system. 

1. Click Logout  

2. A pop-up message will appear stating, “Although you have logged out from CM/ECF, data 
remains in the browser’s memory (and might be available to someone else using your PC). 
Please close your browser now to clear this data.” 
 
 

Maintaining Your Account 
All account information, other than secondary email addresses, is held in your CSO account and can be 
accessed through the Manage My Account option on PACER’s website (www.pacer.gov). It is each 
attorney’s responsibility to keep the account information up to date.  
 
 
 
 

 

Email Information  

The primary email address is added and updated through PACER.  Secondary email addresses are only 
added and updated through ECF.  Email addresses are used for Notices of Electronic Filing (NEF’s). It is 
recommended that all accounts include a primary email address and at least one secondary email address 
for the purpose of receiving NEF’s.   

Updating Primary Email 

1. Navigate to www.pacer.gov. Note that this can also be accessed through ECF by clicking on 
Utilities>Manage your PACER Account 

 

https://www.pacer.gov/
https://www.pacer.gov/
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2. Click on Manage My Account 

 

 

 

 

3. Click on the Maintenance tab. 

4. Click Update E-Filer Noticing and Frequency 

 
 
 
 
 
 
 
 
 
 

5. Check the box to apply your changes to the District of MN.  

 

6. Enter and confirm the Primary Email Address, select frequency and format preferences and click 
Submit.  
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7. The following confirmation screen will appear. Click Close. 
 
 
 
 
 
 
 
 

Updating/Adding Secondary Emails 

1. Click Utilities > Your Account > Maintain Your Account 

2. Click Email information at the bottom of the screen. 

 

 

 

 

 

 

3. If a primary email address is listed, skip to step 5. If no primary email address is listed, click add 
new e-mail address. Note that although primary email addresses are maintained through PACER, 
there must be one listed in ECF in order to add secondary addresses.  Enter the account’s PRIMARY 
email address. Once an address is entered, the secondary email address options will appear on the 
left.  

4. Click add new e-mail address under Secondary e-mail addresses.  

 

 

 

 

 

 

 

5.  Enter the secondary email address and change the configuration options if desired. Note that 
multiple secondary email addresses can be added by clicking on add new email address. 
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Configuration Options: 

Option Description  

Should this e-mail address 
receive notices?  

For the primary email address, the default is Yes.  If set to No, the 
primary email address will not receive notices of electronic filing 
(NEFs)—this is not recommended.  

How should notices be 
sent to this e-mail address?  

Per Filing: Email sent for each individual filing  
  
Summary Report:  One daily email listing all transactions for that 
day, sent on the following day 
NOTE:  If the Summary Report is selected, an additional prompt 
appears, “Should this e-mail address receive a ‘no activity’ notice 
when no summary noticing occurs?” 

• Yes: an email will be sent with the message, “no transactions 
found for this time period” when no activity occurs in the cases 
for which the user is configured to receive summary notices 

• No: no email will be sent unless there were filings  

In what format should 
notices be sent to this e-
mail address?  

Controls the format of the emails—HTML is generally preferred.  
  

Should this e-mail address 
receive general 
announcement notices 
from this court?  

The court prefers that users select Yes so that they will receive email 
notifications regarding important ECF system information such as 
down-time and upgrades.  

 

6. To remove a secondary email address, click on the address on the left and delete it in the  text 
box on the right.  
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7. After all changes have been made, click Return to Person Information Screen. DO NOT use the 
Back button in your browser- information will not be saved if you click Back.  

 

 

 

 

 

 

 

8. You will return to the main account maintenance screen. Click Submit to save changes. A 
confirmation screen will appear.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Continue working in ECF by clicking on any menu item at the top.  
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View Your Transaction Log  

As a free service, ECF filers may view their transaction logs.  This may be helpful to verify that all 
transactions entered are reflected in the system, and that no unauthorized individuals have 
entered transactions into ECF using your login and password. 
 

1. Select Utilities > Your Account > View Your Transaction Log 
 

 
The following window will appear: 

 
2. Enter the Date Parameters, Click “Run Report” 

 The following window will appear listing the transactions for the designated dates 

 
3. Continue Filing or Logout of ECF 
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Note: Scanning is only used for documents that cannot be produced electronically.   
Scanned documents lessen the level of service we provide by slowing down the entire system.   

We are moving away from the utilization of scanned documents internally and ask you to  
do the same whenever possible. 

 
 

Note:  If the displayed document is larger than the screen or consists of multiple pages, use  
the scroll bars to move through the document. Click the View menu for other options for  

viewing the displayed document. Choose the option that is most appropriate for the document. 
 

Requirements 
Hardware and Software Requirements 
The hardware and software needed to electronically file, view and retrieve case documents are the 
following: 
 

● A personal computer running a standard platform such as Windows or Macintosh 
● A PDF-compatible word processor like Macintosh or Windows-based versions of 

WordPerfect or Microsoft Word 
● An Internet Service provider 
● A Web browserSoftware, such as Adobe Acrobat, to convert documents from a word 

processor format to portable document format (PDF).  
● Adobe Acrobat Reader, which is available for free, is needed for viewing PDF documents 
● A scanner may be necessary to create electronic images of documents not in your word 

processing system 
 

 
 

How to View a PDF File 

1. Start Adobe Acrobat program 
2. Click File menu > Open 
3. Click the location and file name of the PDF document to be viewed 
4. Adobe Acrobat Exchange loads the file and displays it on the screen 

 

How to Convert Documents to PDF Format 

The conversion process requires special software such as Adobe Acrobat Writer or FinePrint 
pdfFactory.  Some software (e.g., WordPerfect and Microsoft Word) have Acrobat components 
built-in or available as add-ins.  These can be used to convert documents to PDF. The District 
Court of MN is not concerned with what software is used to convert the file. Options besides 
Adobe Acrobat include any features already in your word processing software, or any of the 
following: 
 

● 602Pro Print Pack 2002 ● LeadTools ePrint 3.0 
● BCL easy PDF 3.1 ● pdf995 and pdfEdit 995 
● eDocPrinter PDF Pro 5.58 ● PDF-XChange 2.5 
● eXPert PDF Printer 2.0 ● Jaws PDF Creator 3.0 
● FinePrint pdfFactory PRO 1.57 ● Win2PDF Pro 
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Once PDF conversion software is loaded on your computer: 

a. Open the document to be converted 
b. Select Print option (generally found in the File menu)  
c. Change printer option to the PDF choice available (A drop-down menu with a list of 

printers is displayed) 
 

 

 

 

 

d. “Print” the file. The file should not actually print out; instead the option to save the file as a 
PDF format file appears (below):   

 

 

 

 

 

 

 

 

 

 

 
 
 

e. Name the file, giving it the extension “.PDF” and click the Save button. 
 

 

 

 

Note:  Make a note of the file location so you can find the document  
later when you are ready to upload it to ECF.   

Change the location if necessary by clicking in the “Save in” area of the window. 
 

 

NOTE:  Depending on the word processing program being used, it may be necessary to 
find the printer selection option elsewhere.  At that point, change the printer to  

Adobe PDF, and follow the directions above. 
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PDF/A Documents 
PDF/A is a standard format that allows for the long-term archiving of electronic documents with 
the assurance that the documents will be accessible in the future.  CM/ECF will now accept both  
PDF and PDF/A documents. 
 

Creating a PDF/A with Microsoft Word 
1. To create a PDF/A directly from MS Word, the user must update the PDF conversion 

settings. In Word 2007, click on Preferences in the Acrobat menu in the ribbon:  
 

 
 
In older versions of Word, go to Adobe PDF>Change Conversion Settings to access the PDFMaker 
window. 
 
2. In the PDFMaker window, click the Create PDF/A-1a:2005 compliant file checkbox, then 

click OK.  
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Creating a PDF/A with Corel WordPerfect X4 
Note: Older versions of WordPerfect do not include PDF/A in the Compatibility options. 
 
1. To create a PDF/A directly from WordPerfect X4, click on File> Publish to PDF, then click 

Settings.  
 

 
 

2. In the Publish to PDF Settings window, select PDF/A-1a from the Compatibility dropdown, 
then click OK.  
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Using Hyperlinks in PDF/A Documents 
To access hyperlinks in a PDF/A document, in Adobe Acrobat/Reader, go to Edit> Preferences> 
Documents, and select Never in the PDF/A View Mode dropdown list. 
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General Information 

Filers will use the Criminal feature of ECF to electronically self-file and docket with the Court a 
variety of pleadings and other documents for criminal cases. 
 
Selecting ECF Features 
The following features are accessible from the menu bar at the top of the main window. 

 

 

Feature Use this option to: 

Civil Electronically file all civil case pleadings, motions, and other court 
documents  

Criminal Electronically file all criminal case pleadings, motions, and other court 
documents. 

Query 
Search by specific case number, party name, or nature of suit to retrieve 
documents that are relevant to the case.   
You must login to PACER before you can query ECF. 

Reports Retrieve docket sheets and cases-filed reports.  You must login to PACER 
before you can view an ECF report. 

Utilities View your personal ECF transaction log and maintain personal ECF account 
information. 

Search 

Use to find and get to the menu option or docket event that you need. Type 
in a partial or full word and a complete list of menus and events containing 
the word is displayed. The items appearing are links to additional 
information about the topic or to the first screen of the searched event for 
d k i   

Logout 
Sign out of ECF and prevents any filing with your password until the next 
time you log in. Only one user can be logged in using the same 
login/password at once. 

 
See a help file for the screen you are viewing. 

 
General Rules and Manipulations 

 
Correcting a mistake: 

Use the [Back] button on the browser toolbar to go back and correct an entry made on a 
previous screen. However, once the document is transmitted to the court, only the court can 
make changes or corrections.   
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Signatures; Affidavits of Service 

A pleading or other document requiring a signature must be signed in the following manner:  
 
s/Pat Attorney  
Pat Attorney 
Bar Number 12345 
Attorney for (Plaintiff/Defendant) XYZ Company 
ABC Law Firm 
123 South Street 
Minneapolis, MN 55415 
Telephone: (612) 555-5555 
Fax: (612) 555-5554 
emailaddress@domain.com 

 
In the case of a stipulation or other document to be signed by two or more persons, the 
following procedures apply: 
 
a. The filing party or attorney shall initially confirm that the content of the document is 

acceptable to all persons required to sign the document and shall obtain the physical 
signatures of all parties on the document. 

 
b. The filer then must file the document electronically, indicating the signatories with an 

“s/signature” (e.g., “s/ Jane Doe,” “s/ John Smith,” etc.) for each signatory. 
 
c. By filing the document, the attorney certifies that: (1) the document has been signed by all 

necessary people, including affiant and notary; and (2) if applicable, and the ink signed 
originals exist and will be available in their office for inspection. These documents should 
be retained in accordance with the retention rules required by the Eighth Circuit and 
Federal Circuit. 

 
d. A non-filing signatory or party who disputes the authenticity of an electronically filed 

document containing multiple signatures or the authenticity of the signatures themselves 
must file an objection to the document within 14 days of service of the document. 
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Mailing information for a Case  

Attorneys can check ECF to see if a party is registered to receive e-mail noticing before uploading a 
filing in ECF.   
 

1. Select Utilities > Miscellaneous > Mailings > Mailing Info for a Case 

 
2. Select Mailing Info for a Case 

 

    
3. Enter the Case Number, Click “Find This Case” then Click “Sumbit” 

The following window will appear: 

 

 

 

 

 

1. Enter the Case Number, Click “Find This Case”  
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The following window will appear listing the Case Number: 

 

 

 

 

 

 

 

2. Click “Submit” 

A window similar to the following will appear with case specific mailing information: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

3. Begin Filing or Logout of ECF. 

 
 
 

NOTE:  If any attorney names appear under the “Manual Notice List”, these  
attorneys need to be noticed in the conventional manner. 
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Filing Documents for Criminal Cases 

There are eight basic steps involved in filing a document.  These are essentially the same for each 
event filed in ECF:  

1. Select the type of document to file  

2. Enter the case number in which the document is to be filed 

3. Designate the party(s) filing the document 

a. IMPORTANT: If the case has multi-defendants, be sure to only select the defendant 
you represent and on whose behalf you are filing the pleading for. 

 
b. Please do NOT select the box next to the master case, unless you are filing the 

pleading on behalf of ALL defendants. 

 
4. Specify the PDF file name and location for the document to be filed 

5. Add attachments, if any, to the document being filed 

6. Modify docket text as necessary 

7. Submit the pleading to ECF 

8. Receive notification of electronic filing 
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Filing a Motion  
This section of the User's Manual describes the process for filing a Motion in ECF.  The process is 
similar for filing other pleadings in ECF. 
Select the appropriate menu from the ECF Menu Bar for filing: 
 

1. Click Criminal > Motions and Related Filings > Motions 
 

 
 
 
 
 
 
 
The following window will appear: 

 
 
 
2. Click the Next button 

 
The following window will appear: 

 

 
 

3. Click the Next button 
 
 
 

 



CM/ECF User’s Manual – Criminal  U.S. District Court, District of Minnesota 
 

  Page 24  

4. Enter the case number, then: 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
If… Action Then 

Multi-Defendant Case List of all 
defendants appears 

Important: Click the box 
next to the defendant you 
represent and on whose 
behalf you are filing the 
pleading for. Please do 
NOT select the box next to 
the master case, otherwise 
you will be filing the 
pleading on behalf of all 
defendants. Click Next 

Number is entered correctly, 
click 

  
Click Next 

Number is entered 
incorrectly, click 

 
 

 
 

Re-enter number, click Find 
This Case 

Invalid case number 
message appears, click 

 Re-enter number, click Find 
This Case 

Multiple case numbers 
match the one entered 

Another window 
appears 

Click on the specific case 
number you are filing in 
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5. Click on the party(s) filing the document, Click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

If this is the first time the attorney is filing in the case, the following window will appear.  It is 
necessary to create the attorney/party association as follows:   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Necessary) 
6. Check the box in front of the party’s name to link the attorney and party together 

 
 

NOTE:  If you represent multiple defendants you may select multiple parties by holding down the control 
key while pointing and clicking on each party of the group. 

 
A Notice of Appearance needs to be filed in order for the attorney to be added to the case  

per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents. 
 

 8  7 

9 

6 
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(Optional) 
7. Check the box in front of Lead if attorney is lead attorney  

 
(Necessary) 
8. Check the box in front of Notice to receive notification when any documents are filed in this 

case 
 
9. Click Next 

 
The following window will appear: 
 
 
 
 
 
 

 

 

 
 
 
 

 

 

10. Click the type of motion being filed.  It will appear on the right side of the window, Click 
Next 
 

 

 

 

NOTE:  An alternative when looking for the motion to select, type a portion of the  
event name to reduce the length of the event list.   
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The following window will appear: 
 

 
 
 

11.  
 
 

 
12. Click Browse to locate the appropriate document 

 

The following window will appear: 

 

 

 

 

 

 

 

 
 

13.   Navigate to the appropriate directory and file name of the PDF document to be filed 
 
 
 
 
 

NOTE:  You must attach an electronic copy of the actual pleading during these steps.   
All documents filed in ECF MUST be in PDF format. 

Please refer to the Criminal Procedures Guide, Section VI. Exhibits for additional information. 
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NOTE:  It is recommended for the user to verify the correct document has been selected 
before linking it to the filing.  To do so, right-mouse click on the selected file.   

A short-cut menu will appear.  Click Open  
 
 
 
 
 
 
 
 

Adobe Acrobat or Reader will open the PDF document.  View and confirm  
document to be filed.  Close the Adobe program.   

 
From this point forward, this informative note will not be included in the documentation. 

 
 
 
 
 
 

  
 
 

14. Click on the file name and Click Open (or double-click on the file) to link it to the filing 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following window will appear: 
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15. If there are No Attachments to the Motion, click Next 

The following window will appear: 

 

 

 

 

 

 

 

 

16. Click Next 

The following window will appear: 

 

 

 

 

 

 

 

 

The “Source Documents Path”  
is solely a marker to list the  
document/s attached to this  

filing event. 
 

 

NOTE:  Unless filing an amended document, 
use of the drop-down options is not 

recommended; editing the docket text field is 
acceptable when appropriate. 
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17. Confirm information in window, Click Next to submit the Motion 

 

 

 

 

The Notice of Electronic Filing window appears:  

 

 

 

 

 

 

 

 

 

 
 
 
 

NOTE: This is the last screen to view before submitting the pleading.  If corrections need to be 
made, click the Back button to locate the desired window in which changes are needed.   

To abort this filing event, click any item on the blue menu bar. 
 

NOTE: The Notice of Electronic Filing (NEF) 
confirms the completion of this filing  

event and acceptance by the ECF system. 

This pleading is now an official court document. 

The NEF will be emailed to the addresses  
associated with this case 
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Filing a Memorandum of Law 
This section of the User's Manual describes the process for filing a Memorandum of Law in ECF.  
The process is similar for filing other pleadings in ECF. 
 
Select the appropriate menu from the ECF Menu Bar for filing: 

1. Click Criminal > Motions and Related Filings > Supporting Documents and Responses 

 

 

 

 

 
 
 
The following window will appear: 

 

 

 

 

 

 

 

 
 

2. Click Next 
 

The following window will appear: 

 

 

 

 

 

 

NOTE:  ECF will automatically populate the case number after the case number has been  
initially entered.   Continue filing the Memorandum or abort the filing by clicking on the  

Criminal menu to restart this event.   
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3. Confirm case number, Click Next 

 

 

 

The following window will appear: 

 

 

 

 

 
 
 
 

 

4. Click the type of memorandum being filed.  It will appear on the right side of the  
window, Click Next  

 
The following window will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click on the party(s) filing the document, Click Next 
 

 

 

 

NOTE:  If you represent all defendants or all plaintiffs you may select the entire group by 
holding down the control key while pointing and clicking on each party of the group. 

 
From this point forward, Step 5 will only be listed; the screen shot will not be included. 

 

A Notice of Appearance needs to be filed in order for the attorney to be added to the case  
per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents 

NOTE:  With most events, a second case number verification window, Step 3 above, appears.  
This window is another opportunity for the filer to ensure the correct case is being filed in. 

From this point forward, Step 3 will only be listed; the screen shot will not be included. 
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NOTE:  From this point forward Step 7, above, will be listed only; screen shot will not be included. 

 

The following window will appear: 

 
 
 

6. Click Browse to locate the appropriate document 

The following window will appear: 

 

 
 
 
 
 
 
 
 
 
 

7. Navigate to the desired PDF document to be filed 
 
 

 
8. Click on the file and Click Open (or double-click on the file) to link it to the filing 
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The following window will appear: 
 

 
 

9. Click Next 
 
The following window will appear: 
 
 
 
 
 
 
 
 
 
 
 

10. Click in the box to select the event to which this memorandum relates, Click Next 

The following window will appear: 
 
 
 
 
 
 
 
 
11.  Click Next 
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The following window will appear: 

 

 

 

 

 

 

 

 

 

 

12. Confirm information in window, Click Next to submit the Memorandum 
 
 The following Notice of Electronic Filing will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: This is the last screen to view before submitting the pleading.  If corrections need to be  
made, click the Back button to locate the desired window in which to make changes.   

To abort this filing event, click any item on the blue menu bar. 

From this point forward, this informative note will not be included in the documentation. 

NOTE: The Notice of Electronic Filing (NEF) confirms the completion of this filing event and that  
is has been accepted by the ECF system.   

This pleading is now an official court document.   

From this point forward, this informative note will not be included in the documentation, and  
the Notice of Electronic Filing step will only be listed; the screen shot will not be included. 
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Filing a Position on Sentencing  
This section describes the process for filing a Position on Sentencing in ECF.  The process is 
similar for filing other pleadings in ECF.   
 
In this illustration, the ECF Search Feature will be used to locate Other Documents (the 
appropriate event) in which to file the Position on Sentencing.  This option may help to increase 
efficiency for the Filer and the Court.  The Search Feature may be used to locate any criminal filing 
event. 
 
To use the Search Feature: 

 
1. Click Search 

The Search Menus and Events box will appear: 

 

 

 

 

 

 

 

 

2. Enter in part or all of desired search text, Click the Search button 
 
The following window will appear listing the menus containing the result of the text search: 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the appropriate Event Menu link to begin filing the Position on Sentencing 
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4. Enter in the case number 
 

5. Click Find This Case 
 

6. Click Next 
 
 
 
 

 

 

 

 

 

 

 

 

The following window will appear: 

 

 

 

 

 

 

7. Click Next 
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The following window will appear: 

 

 

 

 

 

 

 

 

8. Click the type of memorandum being filed.  It will appear on the right side of the  
window, Click Next  

 
 
 
The following window will appear: 
 

 
9. Click Browse to locate the appropriate document 

10. Navigate to the appropriate directory and file name of the PDF document to be filed 

11. Click on the File and Click Open (or double-click on the file) to link it to the filing 

12. Click Next 

 

 

 
 

NOTE:  Because of the similarity to other events, minimal screen shots will be included in this section. 
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The following window will appear: 

 

 

 

 

 

 

 

 

 

12. Click on the party(s) filing the document, Click Next 

 

 

 

 

The following Docket text window will appear: 

 

 

 

 

 

 

 

13. Click Next 

14. Click Next, again, to submit the filing  

The Notice of Electronic Filing window will appear. 

 

 
 

NOTE:  If you represent multiple defendants you may select multiple parties by holding 
down the control key while pointing and clicking on each party of the group. 

 

A Notice of Appearance needs to be filed in order for the attorney to be added to the case  
per the Criminal Procedures Guide, Section II. Electronic Filing and Service of Documents 
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Filing a Certificate of Service on Proposed Order 

Under LR 5.4, the NEF generated by ECF constitutes a certificate of service with respect to those 
persons to whom electronic notice of filing is sent, and no separate certificate of service need be 
filed with respect to those persons. 

If service is not made through ECF, the filing party must file a certificate of service in ECF.  The 
certificate must state the manner in which service or notice was accomplished on each party so 
entitled.  

Filers are required to serve copies of any electronically filed pleading, document, or proposed 
order to parties not served electronically by ECF according to the Federal Rules of Civil Procedure. 

Certificates of Service can either be filed as: (a) an attachment in ECF during a filing or (b) a 
separate filing. If the certificate of service is filed as an attachment to a filing, the filer must first 
find out ahead of time who: 

• will receive the filing by e-mail   

• must receive hard copies of the filing 
 
To determine the party mailing information, Click Utilities > Mailings > Mailing Info for a Case  
 

1. Click Criminal > Other Filings > Service of Process    

 

 
2. Enter or confirm case number, Click Next, Confirm case number again, Click Next 

3. Click the type of Event being filed (e.g., Certificate of Service or Certificate of Service on 

Proposed Order), Click Next  

4. Click Browse to locate the appropriate document 

5. Navigate to the appropriate directory and file name of the PDF document to be filed 

6. Click on the file and Click Open (or double-click on the file) to link it to the filing 

7. Click Next, Click on the party(s) filing the document, Click Next 

8. At the prompt, “Check the box next to the appropriate motion or stipulation to which your 

proposed order relates,” Click Next 

 

NOTE:  Because of the similarity to other events, minimal screen shots will be included in this section. 
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9. Check the box next to the appropriate event(s) to which your Certificate of Service relates.  

 

10. Click Next 

11. Confirm information in window, Click Next to submit the Certificate of Service  

 
The Notice of Electronic Filing window will appear. 
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SAMPLE Certificate of Service ON PROPOSED ORDER 

 

IN THE UNITED STATES DISTRICT COURT 

FOR THE DISTRICT OF MINNESOTA 

 

[Name of Plaintiff(s)]  

                               Plaintiff(s) 

v. 

[Name of Defendant(s)]  

                              Defendant(s) 

 

CERTIFICATE OF SERVICE ON 

PROPOSED ORDER 

Case No.: [Case Number with initials] 

 

I hereby certify that on (date), I caused the following proposed order: 

[List documents to be filed and served] 

 

to be filed with the court via email to the following judge who is hearing the motion: 
[List name and email address of judge to whom you will send the proposed order] 
 
 

and I certify that I caused a copy of the proposed order to be emailed or mailed by first class mail, 
postage paid, as noted below, to the following: 

[List names and method of service of those on whom you will serve the proposed order] 
 

 

 

Dated: ________________, 20___  s/ Attorney’s Name  

Attorney’s Typed Name 

 



CM/ECF User’s Manual – Criminal  U.S. District Court, District of Minnesota 
 

  Page 43  

Appendix A 

Additional Information Regarding ECF  
 
Sealed Documents 

For more details about filing under seal, please refer to the Criminal Procedures Guide, Section II, 
part B and the Sealed Criminal User’s Manual.   
 
Documents Filed In Error  

A document incorrectly filed in a case may result from: a) uploading  the wrong PDF file to a 
docket entry; b) entering the wrong case number and not discovering the error before completing 
the transaction; or c) selecting the wrong document type from the menu. 
 
Uploading the wrong PDF file to a docket entry or entering the wrong case number 
 
After a document is filed electronically, corrections to the docket must only be made by the Clerk’s 
Office.  ECF will not permit the filer to make changes to the document(s) or docket entry once the 
transaction has been submitted. 
 
Documents filed in error in the correct case (e.g., wrong version of the document attached, wrong 
event code, etc.) must remain part of the record as filed.  Upon discovery of error, the filer must: 
Call the Clerk’s Office Help Desk at 612-664-5155 or866-325-4975.  Clerk’s Office staff will edit the 
docket text of the incorrect entry indicating “DOCUMENT FILED IN ERROR” in all caps at the 
beginning of the docket entry. The user should immediately file the correct document in the case in 
ECF, and modify the title of the pleading as appropriate (e.g., "Amended", "Substituted", 
"Corrected"). 
  
If a document is filed in the wrong case, the filer must immediately call the Help Desk at 612-664-
5115 or866-325-4975. The Clerk’s Office will edit the docket text of the incorrect entry indicating, 
“DOCUMENT RESTRICTED-FILED IN WRONG CASE” in all caps at the beginning of the docket 
entry. The user should then file the document in the correct case. 
 
Selecting the wrong document type 

In the event you selected and highlighted a file that is not in PDF format, ECF will display the 
following error message after you click on the [Next] button. 
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NOTE:  For moderate length paper attachments, consider dividing them into two or more smaller 
attachments, scanning, and filing them electronically. 

 

1. ECF will not permit you to select a file for your pleading that is not in PDF format. 

2. Click on the [Back] button and ECF will return to the attachment screen.  

3. Select and highlight the PDF file of your pleading and proceed as before. 

 

Failure to Select a Document to File 

If you fail to select a document to file with your pleading, ECF will display the error message 
depicted below. 

 

 

 

 

 

If you click [OK] from the screen depicted above ECF will return you to the Attachments screen.  
You cannot proceed without attaching a PDF document. 
 

Attachments and Attachment Size  

Attachments electronically filed must be less than 15 MB or 15, 360 KB in size, after the document 
has been converted to PDF. 
 
 
Attorneys may seek leave of the court to file conventionally if attachments and exhibits are 
voluminous.  Refer to the Criminal Procedures guide, Section VI. Leave to File Conventionally for 
more details on this matter.   
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Appendix B  

Viewing Restricted Filings in ECF 
 
Documents electronically filed in ECF may have different restriction levels, i.e. sealed, court only, 
applicable party, or ex parte. When both the document and the docket entry are restricted, the 
docket report will have skipped document numbers. A text only entry will indicate that the 
document is restricted and identify its docket number.  
 
If a user does not have appropriate access to view a restricted document, when clicking on the 
document number, the user will be prompted with a message stating the document is not 
available, or you do not have permission to view this document. 
 

If a document is restricted and the user has appropriate access to it, when clicking the  on the 
document number the user will be prompted for his/her CSO login. This is simply a security 
measure to ensure that the user has proper access to view the document(s).  
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Appendix C  

PACER Fees Window 
When accessing or printing a document that incurs PACER fees a Transaction Receipt table 
appears at the bottom of the window.  As seen below, this table provides the total charges billed. 
 
 
 
 
 
 
 
 
 
Appendix D 

The Federal Rules and Personal Identifiers 
Under Fed. R. Crim. P. 49.1(a), unless the court orders otherwise, an electronic or paper filing with 
the court that contains an individual’s social-security number, taxpayer-identification number, or 
birth date, the name of an individual known to be a minor, or a financial-account number, or the 
home address of an individual, the party or nonparty making the filing may include only:  

 
a. The last four digits of the social-security number and taxpayer-identification number;  
 
b. The year of the individual’s birth;  
 
c. The minor’s initials;  
 
d. The last four digits of the financial-account number; and  
 
e. The city and state of the home address.  

 
In addition, exercise caution when filing documents that contain the following: 
 

f. Personal Identifying Number (e.g., driver’s license number); 
 

g. Medical Records, Treatment and Diagnosis; 
 

h. Employment History; 
 

i. Individual Financial Information; 
 

j. Proprietary or Trade Secret Information. 
 

Under Fed. R. Crim. P. 49.1(b), the redaction requirements do not apply to the following:  
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a. A financial-account number or real property address that identifies the property 

allegedly subject to forfeiture in a forfeiture proceeding;  
 
b. The record of an administrative or agency proceeding;  
 
c. The official record of a state-court proceeding;  
 
d. The record of a court or tribunal, if that record was not subject to the redaction 

requirement when originally filed;  
 
e. A filing covered by Rule 49.1(d) ; and  
 
f. A pro se filing in an action brought under 28 U.S. C. §§ 2241, 2254, or 2255.  
 
g. A court filing that is related to a criminal matter or investigation and that is prepared 

before the filing of a criminal charge or is not filed as part of any docketed criminal 
case;  

 
h. An arrest or search warrant; and  

 
i. A charging document  

 
Pursuant to Fed. R. Crim. P. 49.1, in addition to filing a redacted version of the document in ECF, a 
party filing a document containing personal identifiers may also file: 
 

1. An unredacted copy of the document under seal without seeking leave of the court in 
accordance with Section V.D. of the Criminal ECF Procedures Guide regarding filing 
documents under seal; or 

2. A reference list under seal without seeking leave of the court in accordance with Section 
V.D. of the Criminal ECF Procedures Guide regarding filing documents under seal. The 
reference list must contain the complete personal identifier(s) and the redacted identifier(s) 
used in its place in the filing. 

 
To file documents containing personal identifiers: 

1. File the redacted version of the document electronically in ECF. 

2. If filing an unredacted original under seal, the filer must: 

 
a. Clearly state one of the following in the document heading: 

 
i. SEALED PURSUANT TO FED. R. CRIM. P. 49.1- UNREDACTED ORIGINAL 
(Redacted Document filed in ECF as Document # [number]); or 
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ii. SEALED PURSUANT TO FED. R. CRIM. P. 49.1 - REFERENCE LIST (Redacted 
Document filed in ECF as Document # [number]). 
 
 

b. File the sealed unredacted original or reference list electronically in ECF. 
 

 
Mail or deliver TWO COURTESY COPIES (with a copy of the NEF) of the sealed document, as 
required by Section I, Part F of the Criminal ECF Procedures Guide, to the District or Magistrate 
Judge handling the matter in a separate envelope. 
 

a The sealed document shall be served conventionally, with a copy of the Notice of 
Electronic Filing (NEF), by the filer on parties who are entitled to service. The e-notice 
of the court’s receipt of these documents shall not constitute service. 
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Sample of Reference List of Personal Identifiers Redacted  
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Appendix E 

Creating an Appendix with Document Links 
 
A set of radio button options labeled Include documents in Appendix and Include document 
hyperlinks in Appendix appear at the bottom of the Docket Report. These options allow users to 
indicate if the PDF documents they selected for inclusion in the appendix docket sheet should be 
appended to the docket sheet or if hyperlinks to those documents should be included instead. 
 

Options for Creating an Appendix 
When the Docket Report is run with the Create Appendix option selected, two radio buttons are 
included at the bottom of the report: Include documents in Appendix and Include document 
hyperlinks in Appendix.  
 

   
 

Creating an Appendix with the “Include documents in Appendix” Option 
If the Include documents in Appendix option is selected when the appendix is generated, the 
application produces a PDF version of the docket sheet with the selected documents appended.  
 
Creating an Appendix with the “Include document hyperlinks in Appendix” Option 
If the Include document hyperlinks in Appendix option is selected when the appendix is generated, 
the application produces a PDF version of the docket sheet that does not include the documents 
from the case record.  
 
Instead, this PDF includes document hyperlinks which direct the user clicking on them back to the 
District court’s CM/ECF application to view the document(s). 
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Sample Appendix PDF with Document Hyperlinks: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



CM/ECF User’s Manual – Criminal  U.S. District Court, District of Minnesota 
 

  Page 52  

Appendix G 

Accessing the New Cases Report 
The New Cases Report lists new civil and criminal cases filed in the U.S. District Court, District of 
Minnesota each day. It indicates the date and time (within the hour) the case was assigned, case 
number, case name, the District Judge assigned to the case, and the Magistrate Judge assigned to 
the case. The information will be available on the New Cases Report for 30 days. This report is 
designed to assist the public with viewing new case filings in the U.S. District Court. The Judge 
assignments in the New Cases Report are listed with their initials. Click on the Judge Initials link 
to view a listing of the Judge’s initials and corresponding full names. 

 
1. To access the New Cases Report click on the District of Minnesota’s Web site at: 

www.mnd.uscourts.gov 
 

2. Click on the New Cases tab> Access to the New Cases Report.  

 
 
 

 

 

 

 

 

 

 

 

 

http://www.mnd.uscourts.gov/
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Appendix H 

Mobile Query 
The mobile query interface offers a simplified user experience optimized for display on mobile 
devices. This interface incorporates the following functions: 
 

• Search interface 
• Party selection from party name search result list 
• Case selection from case search result list based on case or party name search 
• Attorney information for selected case 
• Party information for selected case 
• Deadlines/Hearings for selected case 
• Docket entries for selected case 

Accessing the Mobile Query 

Users can access the mobile query via one of the following locations: 

1. The Mobile Query link on the Query selection criteria page: 

 
2. The Mobile Query link on the Query results page. 

 

 

 

 

 

  

3. A case link from the mobile PACER Case Locator. 
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Mobile Query User Interface 

All interfaces in the mobile query include five elements on each page: 

1. Back button ; 
2. Title CM/ECF Mobile—MND; 

3. Logout button ; 

4. Court home page button ; 
5. Search field for party name or case searches. 

 
 

 
 

The default search screen contains one text field that allows users to search by case number, party 
name, or attorney.  
 
At the bottom of each page, a Full Site button provides access to the standard-formatted 
application interface page.  If the user clicks the Full Site button, the full site is set as the default 
for approximately twelve hours.  If any specific page generates a PACER billing receipt, a 
summary form of the billing information is displayed in the black bar along the bottom of the 
page. 
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Name Searches 

For name searches, the required format is Last Name, First Name, where a comma separates the 
two parts. The first name is optional.  When searching by name, the user must enter at least two 
letters of the last name.  If only one letter is entered, the search will only find parties or attorneys 
whose last names are exactly that letter. 
If a party name search returns more than one possible match based on the criteria provided, the 
mobile interface presents the user with a list of all matching names and requires the user to 
select a specific name. 
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If more than eight results are returned on any query page (excluding the docket entries page), 
above the list, an on-page filter allows the user to search the results already downloaded to the 
browser.  This does not affect PACER billing. 
 

 
If only one case is linked to a specific name, the case results for that case is returned. 
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If one name matches the initial search but is linked to multiple cases, or if a user selects a name 
from the result list of a multi-response search, a list of cases associated with that party is displayed.  
When a case is selected from this list, the case query result page is displayed. 
 

 

Case Searches 

Entering a numeric search term triggers a case number search.  If an alphanumeric search term 
is entered, it triggers a party or attorney name search.  If a case number search returns no 
results, the system automatically runs a name search using the same terms.  Spaces can be used 
in case numbers instead of dashes or other punctuation. 
The case number search does not generate a PACER billing receipt, since the standard query 
application does not bill for the case number lookup.  
 
If a case search returns more than one possible match based on the criteria provided, the mobile 
interface presents the user with a list of all matching cases and requires the user to select a 
specific case before proceeding to the case query result screen.  When a case is selected from this 
list, the case query result for that specific case is displayed. 
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    If only one case matches the case criteria provided, the case query result page is displayed. 
 

 

Case Query Results 

When a search is run, the Mobile Query displays results in the case query result page (see figure 
1). This screen presents the following information: 
 

• case number, short title, and date filed; 
• link to see attorney information in the case; 
• link to see party information in the case; 
• link to see deadline/hearing information in the case; 
• link to show all docket entries, and the number of docket entries that will be shown; 
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• search icon that brings up a search box to find docket entry information that matches the 
text entered, (see figure 2).  

The Case Query Results screen is similar to the full site Query result page, which does not 
produce a PACER billing receipt. Billing will occur based on additional selection from this page. 
 

Figure 1-Case Query Result 

 

Figure 2-Docket Entry Text Search 

 
 

 

Detailed Case Information Displays 

Attorneys, parties, deadlines, and docket entries are listed in similarly formatted lists that wrap 
to fit on small screens. 
 
Each list header shows the case number, item listed, and the number of matches. If more than 
eight items appear in the list, a Filter Items search box at the top of the list allows the user to 
narrow down the list. This Filter Items search box is available on all case details except for 
docket entries. The user is billed for receiving the total data, not for using this filter to hide data 
already received. 
 
Attorney Information 
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Party Information 

 
 
Deadlines/Hearings Information 

 
 
Docket Entries Information 
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Docket Entries Using Text Search 
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The docket entry information includes document numbers, the filed date, and the docket text. 
For documents, the document number appears in its own cell on the left. The entire cell is 
clickable to make clicking the link easier on small screens.  Clicking on a document takes the 
user to familiar ECF screens to view the document. 
 

 
The mobile query ignores PACER billing display preferences and displays PACER receipts via 
the standard ECF PACER interface. 
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